Working with Reaper: concatenating mp3 files

Before beginning in Reaper, you should have gone through these steps:

a. Been assigned a ticket to create mp3s from Jan

b. e-mailed Grace to request the files with this subject line format:
lecture files for LIS (or IMT, etc) XXX needed

c. Checked in your N:\Project Folders\Staff-GA Shared
Folders\Grace_Jan_GSACrew\yourname\instructorname folder to see the zipped folder
or folders

d. Extracted the zipped folders [note: if there are more than 5 zipped folders, extract the
folders in batches instead of all at once].

Next, go to the Reaper site and download the product.
http://www.reaper.fm/download.php

You will also need a copy of lame_enc.dll to put into the main Reaper folder once the program
is installed, found in the GA wiki documents library.

Once Reaper is installed, open the program. You should see a screen with dialog boxes that
looks something like this:

@ REAPER v2.010 - UNREGISTERED SHAREWARE

File Edit View Track Options Insert Help [audio device closed]

1.1.00 1.3.00 2.1.00 2.3.00 3.1.00 3.3.00 4.1.00
0:00.000 0:01.000 0:02.000 0:03.000 0:04.000 0:05.000 0:06.000
() About REAPER [
| Credits | Shareware | License and Lser Agreement | Changelogl
® REAPER New Version Notification =]

REAPER 2.031 is available, with the following updates: -
+improved some render options in renderproject command line option |Z‘
+ added optional SIZE_TO_SOURCE for media tems for autogenerated prl =
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[7] Check for new versions [ Proceed to download pag. ] [ Close ]
@ usster
-inf  -inf
Vigit hittp .//www reaper fm/ for updates

click on both Close buttons.


http://www.reaper.fm/download.php

Using the program

1. from the Insert menu:

choose Media File. The default browser window will appear. Note that it's inside the Reaper
folder under Program Files.

2. Add a shortcut inside this default folder that goes to your GA folder on the N: drive as
displayed here.
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3. Once you have made a shortcut, navigate in this window to the folder where Grace has put
the zipped lecture folders. If you don't see anything in the folder, go back to Windows
Explorer and make sure you have extracted the folders first, so that Reaper will be able to
use the contents. You should see folders like this:

. & Ray » LorraineBruce » v [y

oog -
¥ oom Views - ‘ Mew Folder

Namej Date medif... Typ

) Aszessment
153

| learningl
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4. Open one of the unzipped folders, which will have multiple subfolders and files. Open the
data subfolder.

< Aszessment -

=== -
oog Yiews =+ ‘ Mew Folder

Name’ Date modif...
J data
) scorm 2004

J scorm_support

5. Select all of the mp3 files inside, but not any other files. [NOTE: If there are mp3s that are
out of order, or some are "missing," you'll need to check that the sound file order

matches the order in the slide show. Go to steps 5a. and 5b.]
.
Marme Date modif.. Type Siz

. thumb
14| a2dd .mp3
& 2242 mp3
& 3243 mp3
& a24ud.mp3
1| a24x5.mp3
4| a2duB.mp3
|| 32457 mp3
|| a24x8.mp3
] a24:9.mp3
|| a24:10.mp3
|§] a24:d1.mp3
|§] a24:12.mp3
|| a24:13.mp3
| a24:14.mp3
4| a24:15.mp3
4| a24:16.mp3
|| a24:17.mp3




5a. [optional: see step 5 above.] Check the correct order of the mp3s by going opening the
data folder you are working on in a new Windows Explorer window. Open the viewer.xml file.
If you are more comfortable with XML Spy, that program will open the file by default, otherwise
you can right-click on viewer.xml and choose Open in Wordpad. In Wordpad, viewer.xml looks
like this:

viewer.xml - WordPad

File Edit View Inset Format Help

DEE & #M By

k?xml version="1.0" encoding="utf-8"7>

<presentation width="720" height="540" start="play"

buildNum="5.1.269.269">
<presentationTitlerAssessment</presentationTitle>
<presentationDescription>Types of assessment

</presentationlDescription>

<speakers>
<speakers>
<name>Lorraine Bruce</name>
<3peakerTitle>lecturer</speakerTitle>
<email>lbrucelu.washington.edu</emails>
</speaker>
</speakers>
<backgrounds>

<background url="Master80000026.swE"/ >
<background url="Masterg80000025.swi"/ >

</backgrounds>
<search url="srchdata.xml"/>
<zslides>

<2lide id="256&" frameRate="30" totalFrames="207"
adwvance="auto" type="normal">
<content url="Slidel.swf"/>
<zlideBackground index="0" frameToPlay="1"
duration="2" showAfterFrame="0"/>
<z3lideTitle>Module 4 </slideTitle>
<notes isHTML="true"></notes>
¢z3lideThumbnail url="thumb.swf" frame="1"/>
<zlideSpgaker 1ndex="0";}F
<audio udl="aZ4xl.mp3"/>
</2lide>
<z3lide id="282" frameRate="30" totalFrames="11&7T"
advance="auto" type="normal":>
<content url="Slidel.swi"/>
<zlideBackground index="1" frameToFlay="1"
duration="2" showhfterFrame="0"/>
<zlideTitle>hssessment </ =lideTitle>
<notes isHIML="true"></notes>
<zlideThygbpail yrl="thymh.swf" frame="2"/>
<zlideSpdaker index="0"/}
<audio udl="aZ4x?.mp3"/ >
</3lide>
<glide id="298" frameRate="30" totalFrames="32&7"
advance="auto"™ type="normal">
<content yrl="slide3 swi"/ >

The sound file order in the XML is pointed out by the red boxes.




If the filenames you see in the XML jump around numerically (e.g. a24x4.mp3 is followed by
a24x1.mp3, then a24x2.mp3), the mp3 files MUST be renamed in their proper order. In the
previous example, a24x4.mp3 would need to be renamed a filename that puts it at the top of a
numeric list, like 01.mp3. Then a24x1.mp3 becomes 02.mp3, and a24x2.mp3 becomes 03.mp3.
PRINT OUT the viewer.xml file so that keeping track of the order is not a problem. You should
probably not attempt to work on something like this if you think you may be interrupted,
because it's very easy to lose track of your renumbering scheme.

5b. Select all of the renamed mp3s in the folder, but not any other files.

6. Once the mp3s have been selected in Reaper, click the Open button to open them in the
tool. Be sure to choose No at this dialog box:

REAPER Import Options

Irnport files on separate tracks? (no will insert all files on one track)

Ve || No

Note: choosing Yes instead of No (by clicking on Yes or pressing the Enter key) will lead to this
intimidating indow:
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To correct this without closing Reaper and beginning again, follow the steps 6a and 6b below.

6a. [optional, see note above] From the window shown above, choose Cancel and then press
Control +Z (the "undo" keyboard shortcut):
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6b. [optional, see note above] From here, return to the Insert menu (Step 1 above) and follow
the directions from that point, being careful to choose No in Step 5 above.

7. Once you have inserted the media files correctly (choosing No in Step 5 above), the

resulting screen after opening the files should look like this:
Options _Insert_Help

8. Click inside the Reaper workspace (with the tail end of the sound file) and roll the scroll
wheel on the mouse backwards (towards you) a few times, until the display looks like this.
This is so you can see the whole sound file at one time.

[note: the repeated word OFFLINE is showing in these examples because Reaper is not the
program that has the focus of the operating system]

Track Options Insert Help

end of the sound file




9. Go to the File menu and choose Consolidate/Export Tracks... to get this dialog box.

P =
@ Consolidate Tracks L&J

Consolidation Settings
(@) Entire project Loop selection () Custom: Tracks:
Start; | 0:00.000 End: [11:10.589 Length: |11:10.589 @ Al () Selected

I lgnore silence shorterthan 30 seconds (can cause multiple files per track) I
|| Force output format {f disabled, it will be automatically determined pertrack):

= L s 1on L ra T

I Fesample mode: [Better {192pt Sinc - SLOW) v] (if required)

Consolidate to: I.Wﬁ‘u’ ']

WAV bit depth: (7) 8bit  (7) 16bit @) 24 bit
() 32bitfloat ) 64 bit float
Wirite BWF (best’) chunk Allow lange files to use Wavebd

Output
Output consolidated files to directory:
iasaaeiegilzs HEAPER

Lpdate plhject with consolidated files
Sawve hew project as:
C:\Ploaram Files\REAPER\consolidated.mp

Sawe feument project before updating project

[ Process J’ Cancel ]

L ]

10. Change all of the areas inside the red boxes (using the drop-down menu, if present), until
the dialog box looks like this - some new drop-down menus will appear:
@ Consolidate Tracks [&J

Consolidation Settings
(@ Entire project Loop selection () Custom: Tracks:
Start: |0:00.000 End: |11:10.583 | Length: |11:10.583 @ Al () Selected

[ lanore silence shorterthan 30 seconds (can cause multiple files per track)
[ Force output format (f disabled, it will be automatically determined perrack):
T w T
Resample mode: [Good (B4pt Sinc) v] {if required)
Consolidate to: [ MP3 {ame) - ]
Mode: [CBF{ v] [Joint Stereo v] Constant Bitrate:
Qualty: | Normal -
i ——
Output

Qutput consolidated files to directory:
C:\Program Files\REAPER
[] Update project with consolidated files
7] Save new project as:
C:\Program Files\REAPER\consolidated pp
[ Save cument project before updating project

[ Process J[ Cancel ]




11. Now click the top Browse... button and navigate to the folder you want the output to go to.
Consider putting it in the top level of your shared instructor's folder, like this:

Cutput
Output consolidated files to directory:

M:"Project Folders®Staff<GA Shared FoldershGrace_Jan_GSACrew'\Ray' LomaineBruce

Lpdate project with consolidated files

Because Reaper doesn't hang on to that information in the way we are using it, consider
selecting that text and choosing Copy from the right-click menu to be able to paste it back in for
other files in the same folder.

12. Click the Process button to begin:

Cutput

Output consolidated files to directory:

M:Project Folders'Staff45A Shared Folders'Grace Jan GSACrew \FRay'|LomaineBruce

[T Update project with consolidated files
[7] Save new project as:
N:\Project Folders\Staff GA Shared Folders\Grace_Jan_GSACrew

[7] Sawe cument project before updating project

[ Process ]) Cancel ]

e

Which results in this status window.
(@ Consolidate Tracks =

Consolidation Settings
(@) Entire project Loop selection () Custom: Tracks:
Start. |0:00.000 End: [11:10.589 | Length: [11:10.589 @ Al () Selected

[ lgnore silence shorterthan 30 seconds {can cause multiple files per tra
i @ Consolidating...

Cument Output File
MN:\Project Folders\Staff-GA Shared Folders'Grace_Jan_GSACrew \Ray'Lo
MP3 (lame) 22050hz 1ch, 48kbps

Consolidation Status

F
6
[
e

Processing Track 1/1 "a24x1"

|| Save new project as:

N:\Project Folders\Staff-GA Shared Folders\Grace_Jan_GSACren

[7] Save curment project before updating project




13. Once the output process is complete, you are returned to the file displayed in the
Reaper workspace:

Insert  Help

View

Edit Track Options

File

129.1.00

= L i __[ m | 0.0048 center

14. Navigate to the shared instructor's folder on the N: drive in a Windows Explorer window.

Note that there are 2 Reaper-generated files:
i . rubric 1/15/2008 712 PM  File Fq

|¢| 01-a24:1 -consolidated-080115_2005.mp3 1/15/2008 8:05 PM MP3F
¢3Ul-324xl-c::nns::nIidated-ﬂEUllS_EDUS.mp3.reapeaks 1/15/2008 8:05 PM REAPE

15. Double-click on the mp3 file and listen to the first few seconds and the last few seconds to
make sure everything is correct. Rename the mp3 file with something that will tell you and
the instructor which lecture file this is. Often, the name of the folder that the files came
from is named with something that is already useful (like "Assessment" from Step 3 in this

example):

|| assessment.mp3 1/15/2008 8:05 PM

3 01-a24:1-consolidated-080115_2005.mp3 reapeaks  1/15/2008 8:05 PM

Note that the .reapeaks file is a "scratch file" and is only used to build the mp3. You'll be
deleting it and any other files that are not the finished mp3s once you have processed and
output all of the sound files you are working on, and have closed down Reaper.
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16. To continue working on other lecture files without shutting down and restarting Reaper,
first return to Reaper. In the Reaper workspace, press Control + A to select all. Right click on
the sound form:

|
| right-click here I

and choose Remove selected items to get this:
©

File Edit View Track Options Insert [audio device closed]
& = i = = f i

® B

==

In the red box is the current insertion mark, which is where any new inserted file will be placed.
We want that mark to be back at time zero, so click on the zero mark (in the blue box) while the
mouse cursor is shaped like an I-bar to re-position the insertion point at time zero.

17. Return to the Insert menu, and repeat the steps above, starting back at Step 1.
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18. Finally, when exiting Reaper, don't save the project when prompted, as Reaper will
generate additional files you will only have to go back and delete. When prompted to save,
choose No:

REAPER Query =%

Save current project before quitting?

ves (|| No ||} cCancel |

~—_~

19. You're done! All that's left is to move/link the mp3s to the website.

This GA Crew walkthrough/tutorial was put together by Ray Baldwin in April 2008, with assistance and testing by Renee Disch.
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